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Image Viewing, Organizing and Editing Software

ImageBrowser
Ver. 5.8

Instruction Manual

Content of this Instruction Manual
IB is used for ImageBrowser.
In this manual, the windows used in the 
examples are from Mac OS X 10.4.
 indicates the selection procedure of the menu.

(Example: [File] menu  [Close].)
Square brackets are used to indicate items such 
as menu names, button names and window 
names that appear on the computer screen.
Text inside < > indicates a camera switch name 
or icon, or a keyboard key name.
** indicates a reference page.
Click to move to the relevant page.

 : Marks helpful information when a problem 
arises.

 : Marks tips for using the software skillfully.
 : Marks information that should be read 

before use.
 : Marks additional information you may find 

helpful.

© CANON INC. 2007     CT1-7143IBME-000

Switching Between Pages
Click on arrows on the bottom right of the screen.

 : next page
 : previous page
 : return to a page you had previously 

displayed
Click on the chapter headings on the right side 
of the screen to switch to the contents page of 
that chapter. Also, click the item you want to 
read about on the table of contents to move to 
the relevant page.

Help
For information about using IB, refer to Help 
from the [Help] menu or click the [?] button on 
each window and refer to the Help displayed.
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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM 
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM 
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions 
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided 
that the SOFTWARE is used on only one computer at a time. You shall not install or use the 
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, 
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, 
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 

copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer 
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation 
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for 
use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED 
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period of ninety 
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. 
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge 
when returned by you at your expense to your point of purchase and proven to be defective 
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original 
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if 
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE 
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software 
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of 
the SOFTWARE is subject to the United States, Canada and other applicable copyright and 
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its 
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any 
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON 
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS 
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.
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Introduction
ImageBrowser (hereinafter, “IB”) is image viewing, organizing and editing 
software for Canon digital cameras. As well as downloading, viewing and 
printing images you have shot with your digital camera, you can utilize 
your images using the software’s various functions.

Main Features of IB
Download images from your camera to your 
computer
Display a list of images or display 
individual images

Display a list of images in three types of main window (browser 
window)
Display individual images in the viewer window

Print images
Layout print
Print one image per page and index print

Organize images
Edit images

Automatically adjust images
Adjust brightness and color
Trim images
Insert text into an image
Adjust sharpness
Correct red-eye

Utilize images
Attach an image to an e-mail
Use an image as wallpaper or a screen saver

System Requirements

This software program is not compatible with UFS (UNIX File System) 
formatted disks.
ImageBrowser is not a Universal application. It runs under Rosetta on 
an Intel-based Macintosh.

Supported Images

OS Mac OS X 10.3 to 10.4
Computer Macintosh with one of the above OS installed
CPU PowerPC G3, G4, G5 or Intel processor
RAM Minimum 256MB

Display Resolution : 1024 × 768 or more
Colors : Thousands or more

Image type/Camera used Extension

JPEG images
JPEG images shot with a Canon digital 
camera (Exif 2.2 or 2.21-compatible 
JPEG images)

.JPG, .JPEG

RAW images

EOS-1D Mark III EOS-1D Mark II N
EOS-1Ds Mark II EOS-1D Mark II
EOS 5D EOS 40D
EOS 30D EOS 20D/20Da
EOS DIGITAL REBEL XTi/400D DIGITAL
EOS DIGITAL REBEL XT/350D DIGITAL

.CR2

EOS-1Ds EOS-1D .TIF
EOS 10D
EOS DIGITAL REBEL/300D DIGITAL
EOS D60 EOS D30

.CRW

TIFF images Exif-compatible TIFF images .TIF, .TIFF
BMP images Bitmap images .BMP
PICT images PICT images .PICT
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Contents at a Glance
Downloading Images to Your Computer

Download images by connecting your camera and 
computer  p.5

Download images using a card reader  p.6

Image Display and Checking
Look through the images  p.8
Enlarge and view images  p.9, p.14
Check the images efficiently  p.17
Compare multiple images  p.39
Check the shooting information such as shot date  p.41
View the images as a slide show  p.29

Printing
Print one image on one page  p.11
Arrange multiple images on one page and print  p.36
Arrange images freely and print  p.37

Organizing Images
Sort images (ratings)  p.15
Move images to a different location  p.19
Move images in folders to a different location  p.19
Change the image file name and folder name  p.20
Delete images  p.21
Classify images by shot date  p.44
Search for an image  p.46

Image Editing (Adjustment)
Adjust brightness/darkness  p.24
Make the image colors more vivid  p.24
Use automatic adjustment  p.23
Trim parts of an image (trimming)  p.25
Specify an aspect ratio that matches the size of the 
paper on which an image is to be printed (trimming)  p.25

Make an image sharp (sharpness)  p.27
Insert text in an image  p.26
Correct red-eye  p.28
Merge images  p.50
Adjust RAW images  p.51

Utilizing Images
Attach an image to an e-mail and send  p.31
Make an image your computer wallpaper  p.33
Make an image your computer screen saver  p.34

Converting/Saving Images
Change the image size  p.41
Change the image to a different type  p.41
Convert a RAW image to a JPEG or TIFF image  p.51
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Basic Operation
This chapter explains basic operations such as starting up IB, 
downloading images from your camera to your computer, viewing, 
checking and printing downloaded images and quitting IB.

Starting up IB.............................................................  5
Downloading an Image to Your Computer ................  5

Downloading Images Using Your Card Reader............  6
Viewing an Image ......................................................  7

View Images as Thumbnails in the Main Window ........  8
Changing the Display Magnification .........................  9

Enlarging and Viewing Images One at a Time .............  9
Displaying an Image Across the Whole Window (Full 
View Display).......................................................... 10

Printing an Image ....................................................  11
Quitting IB................................................................  12
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Starting up IB
Click the icon on the Dock.

IB starts up and the main window (browser window) appears.

Click

Main window (browser window)

Downloading an Image to Your Computer
Connect the camera and computer with the cable provided and 
download the images saved on the memory card inside the camera.
For downloading images, start up the camera software “EOS Utility” and 
use.

1 Connect your camera and computer and turn the 
camera on.

When IB starts up, connect the camera and your computer with the 
interface cable provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and 
computer, refer to the “EOS Utility Instruction Manual” (PDF 
electronic manual).

EOS Utility starts up automatically.
EOS Utility
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2 Download images.

Downloading of images begins.
The downloaded images are saved in the [Pictures] folder and 
are displayed in the main window of IB.
The downloaded images are sorted into folders by date and 
saved.
Click the EOS Utility [Quit] button to quit EOS Utility and turn the 
camera’s power switch to < OFF >.

Click

Using EOS Utility to download images makes it easier to organize your 
images as they are downloaded, sorted and saved into folders by date.

Advantages of using EOS Utility to download images

You can also download images to the computer using a third-party card 
reader. For downloading images, start up the memory card software 
“CameraWindow MC” and use.

1 Start up IB and then select the save destination for 
the images in the folder area at the left of the main 
window.

2 Load the memory card into the card reader.

CameraWindow MC starts up automatically.

Downloading Images Using Your Card Reader

Click
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3 Download images.

Downloading of images begins.
The downloaded images are saved in the folder selected in step 
1 and are displayed in the main window of IB.
The downloaded images are sorted into folders by date and 
saved.
Click the CameraWindow MC [Exit] button to quit 
CameraWindow MC.

Click

CameraWindow MC

Using CameraWindow MC to download images makes it easier to 
organize your images as they are downloaded, sorted and saved into 
folders by date.

Advantages of using CameraWindow MC to download images

Viewing an Image
Images downloaded to your computer are displayed in the main window.

To select multiple images, click on the images while holding 
down the < > key or < shift > key on the keyboard.
You can select all images in a folder by clicking the [Selecting 
Images] button and then selecting [Select All] from the menu that 
appears.

Main window

Click to select the image

Displays the images in the folder 
that was selected from the folder 
area on the left of the window

The clicked image is 
enlarged and displayed in 
the center of the window

For a list of main window functions, refer to p.64.
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You can change the display mode of the main window to show only a list 
of the thumbnail images.

Click the [List] tab sheet.

The main window display changes to List Mode.

View Images as Thumbnails in the Main Window

Click

To select multiple images, click on the images while holding 
down the < > key or < shift > key on the keyboard.
You can select all images in a folder by clicking the [Selecting 
Images] button and then selecting [Select All] from the menu that 
appears.

Main window (List Mode)

Click to select the image Displays the images in the folder 
that was selected from the folder 
area on the left of the window

For a list of List Mode functions, refer to p.65.
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Changing the Display Magnification
You can change the display magnification of the thumbnail images 
displayed in Preview Mode (p.64) and List Mode (p.65).

Change the display magnification.

You can also change the display magnification by clicking [ ] 
or [ ].
The display magnification of the images changes.

Drag left or right

1 Double-click an image to enlarge.

The viewer window appears.

Enlarging and Viewing Images One at a Time

Double-click
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2 Click [ ] or [ ] to switch to the image you want to 
display.

The shooting information is displayed if you click [ ] (Show 
Information) and select [Show Shooting Information] from the 
menu that appears.
To quit the viewer window, click [ ] on the top left of the 
window.

Viewer window

The [Show Original Image] button appears at the bottom of the window. 
Click this button to display the processed image.

When you display RAW images in the viewer window

For a list of viewer window functions, refer to p.67.

Displaying an Image Across the Whole 
Window (Full View Display)

Double-click on the image you want to display 
across the whole window.

You can also display the image across the whole window by 
clicking [ ] (Full Screen) on the bottom of the window.
The image is enlarged and displayed across the whole window.

To return to the viewer window, click on the window or press the 
< esc > key on the keyboard.

Double-click
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Printing an Image
This section explains how to print one image on one sheet of paper.

1 Select the image to be printed.

To select multiple images, click on the images while holding 
down the < > key or < shift > key on the keyboard.
You can select all images in a folder by clicking the [Selecting 
Images] button and then selecting [Select All] from the menu that 
appears.

2 Display the print settings window.
Click the [Print] button and then select [One Photo per page 
Print] from the menu that appears.

The [One Photo per page Print] window appears.

Click

3 Set the paper type and size, and then click the [Print] 
button.

Printing begins.

One Photo per page Print window

For a list of one photo per page print window functions, refer to p.68.
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Quitting IB
In the main window, select the [ImageBrowser] menu 

 [Quit ImageBrowser].

IB quits.
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Advanced Operation
This chapter explains more advanced operations such as efficiently 
checking, sorting and organizing images, performing general editing of 
images and utilizing your images.

Checking/Sorting Images ......................................... 14
Enlarging and Checking Images One at a Time........  14

Enlarging a Specific Part of an Image ...................  15
Sorting Images...........................................................  15

Extracting Images You Want to Display (Filter 
Display) ..............................................................  16

Arranging Images in the Main Window ..................  16
Efficiently Checking/Sorting Images......................... 17
Organizing Images ................................................... 18

Creating a Folder for Saving Images.........................  18
Moving Images ..........................................................  19

Moving Images in Folders......................................  19
Changing Image File Names .....................................  20

Changing the Folder Name....................................  20
Deleting an Image or Folder ......................................  21
Registering Frequently-Used Folders as Favorite 
Folders ....................................................................  21

Deleting Favorite Folders.......................................  22
Editing an Image ...................................................... 23

Automatic Adjustment Using IB .................................  23
Adjusting Color and Brightness .................................  24
Trimming an Image....................................................  25
Inserting Text into Images .........................................  26

Adjusting Sharpness................................................... 27
Correcting Red-Eye Automatically.............................. 28

Correcting Red-Eye Manually................................. 28
Utilizing Your Images...............................................  29

Viewing Images as a Slide Show ............................... 29
Sending an Image by E-Mail ...................................... 31
Creating Wallpaper from an Image............................. 33
Creating a Screen Saver from an Image.................... 34

Printing Multiple Images on One Sheet of Paper 
(Index Printing) ...................................................... 36
Arranging Images Freely and Printing (Layout 
Printing) ................................................................. 37
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Checking/Sorting Images
You can enlarge images one at a time from a list in the main window and 
check what they look like in detail, and sort them into one of three 
groups with [ ] (ratings).

1 Double-click on the image on the top left of the main 
window.

The viewer window appears.

Enlarging and Checking Images One at a Time

Double-click

2 Click [ ] or [ ] to switch to the image you want to 
display.

The shooting information is displayed if you click [ ] (Show 
Information) and select [Show Shooting Information] from the 
menu that appears.
To quit the viewer window, click [ ] on the top left of the 
window.

Viewer window

Select multiple images in the main window (p.8) and then click on [ ] 
(View Image) (p.65) on the bottom of the main window to display only 
the selected images in the viewer window.

To display only selected images in the viewer window

For a list of viewer window functions, refer to p.67.
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Enlarging a Specific Part of an Image

1 Enlarge an image.
Click the list box and then select the display magnification.

The image enlarges and the navigator window appears.

2 Display the part of the image you want to check.
Drag the enlargement display position in the navigator window 
and display the part of the image you want to check.

To return to full view, select [Fit to window] from the list box.

Navigator window

Enlargement 
display position
Drag to move the 
display position

Display magnification

RAW images cannot be enlarged before they are processed. By clicking 
the [Show Original Image] button on the bottom of the window, the 
image is processed and it can be enlarged.

Enlarging RAW images

You can sort images into one of three groups by attaching [ ] (ratings) 
according to photo subject or theme. Please note that [ ] is 
automatically attached to images shot with your camera.

Increase or decrease a rating.
Click the list box and then select the number of [ ].

Sorting Images
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Extracting Images You Want to Display (Filter Display)
You can extract images displayed in the main window by the number of 
[ ] you have attached to them (ratings).

1 Click the [ ] button.

The extract function appears.

2 Checkmark the number of [ ] you want to extract 
and display.

Only the images with the number of [ ] you have checkmarked 
are displayed in the main window.
To quit the extract display, click the [ ] button 
again.

Arranging Images in the Main Window
You can arrange images in the order of file size or shot date and time.

Select the [View] menu  [Sort]  desired item.

The images are arranged in the order according to the selected 
item.

Sort item Description
File Name Image file names are arranged in the order of 0 – 9  a – z.
File Modification 
Date

Images are arranged in the order of most recently 
updated.

File Size Images are arranged in the order of the smallest file size.
Shooting 
Date/Time

Images are arranged in the order of most recently shot.

Type Images are arranged in the order of BMP images  RAW 
images  JPEG images  PICT images  TIFF images.

Ascending Images are arranged from top to bottom in order of 
sorting criteria.

Descending Images are arranged from bottom to top in order of 
sorting criteria.



17

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

Efficiently Checking/Sorting Images
With Preview Mode that displays images as thumbnails and as single 
images in the same window, you can sort images by the number of [ ] 
while checking efficiently. You can also simultaneously check shooting 
information for images.

1 Enable Preview Mode.

The main window display switches to Preview Mode.
Click

2 Click on a thumbnail image to switch to the image 
you want to check, and then sort with the number of 
[ ].

Preview Mode

Thumbnail image display area

The selected image in the thumbnail 
image display area is enlarged in 
the center of the window

Select the number of [ ] from the list

For a list of Preview Mode functions, refer to p.64.
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Organizing Images
This section explains functions that are useful for organizing images 
such as creating new folders for saving sorted images, moving and 
copying images and deleting unwanted images.

You can create a folder to save sorted images.

1 In the folder area, select the location where the new 
folder is to be created.

Creating a Folder for Saving Images

2 Select the [File] menu  [New Folder].

The new folder is created in the folder selected in step 1.

3 Enter a folder name and press the < return > key.
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You can move or copy images to separate folders and organize them 
according to shot date or theme.

Drag the image to be moved or copied.
To move:Drag the image and release when the image is in the 

destination folder.
To copy: Drag the image while holding down the < option > key 

and release when the image is in the destination folder.

The image is moved or copied to the folder it was dragged to.

Moving Images Moving Images in Folders
You can move or copy folders that contain images, and organize images 
in folders.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the 

destination folder.
To copy: Drag the folder while holding down the < option > key 

and release when the folder is in the destination folder.

The folder is moved or copied to the folder it was dragged to.
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1 In the main window, select the image whose name 
you want to change.

2 Select the [File] menu  [Organize Image]  
[Rename].

The [Rename] dialog box appears.

3 Enter the new name and then click the [OK] button.
The file name changes to the new name.

Changing Image File Names

You can also change the file name in the [File Information] window 
(p.41) or in the information display area (p.64) in Preview Mode.

Changing the Folder Name

1 In the folder area, select the folder whose name you 
want to change.

2 Using the keyboard, enter the folder name and then 
press the < return > key.

The folder name changes to the new name.

Click on the folder name
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Deleted images and folders cannot be recovered. Also, take care when 
deleting folders as all the images inside a folder will also be deleted.

1 In the main window, select the image you want to 
delete, or in the folder area, select the folder you 
want to delete.

2 Click [Send to Trash].

The image or folder is moved to the [Trash] and is deleted from 
IB.
If the [Move to Trash?] dialog box appears, click the [Yes] button.
To delete an image or a folder from your computer, on the 
desktop, select the [Finder] menu  [Empty Trash].

Deleting an Image or Folder
You can register shortcuts for frequently-used folders in the [Favorite] 
tab sheet in the folder area to make images easier to find.
Please note that because the [Pictures] folder is registered as a favorite 
folder by default, the folder icon appears as [ ].

1 Select the folder you want to register.

2 Click the [Add to Favorites] button to register the 
folder.

The folder icon changes to [ ] and the folder is registered as a 
favorite folder.

Registering Frequently-Used Folders as Favorite Folders
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3 Select the [Favorite] tab sheet.

4 Select the registered folder to display the images 
inside the folder.

The images inside the folder appear.

Click

Any changes done to images inside registered folders will be applied to 
the original images. Therefore, please be aware that by editing or 
deleting images inside registered folders, you are in fact editing or 
deleting the original images.

If you have edited or deleted images in folders you have 
registered as favorites

Deleting Favorite Folders
If you no longer need a folder you have registered in the [Favorite] tab 
sheet, you can delete it from this tab sheet.
Please note that as registered folders are shortcuts, the original folder 
will not be deleted when you delete the shortcut.

In the [Favorite] tab sheet, select the folder you want 
to delete and then click the [Remove] button.

The folder is deleted.
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Editing an Image
If the brightness or color of images is different from what you visualized 
when you shot the photo, you can adjust an image using the editing 
functions to bring them closer to what you visualized.
This section explains about automatic adjustment of images, adjustment 
of brightness/saturation, trimming images, inserting text into images, 
adjustment of sharpness and red-eye correction.
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those 
described above and adjustment of RAW images.

The brightness and colors, etc. of the image are automatically adjusted.

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Auto Adjustment] in the 
menu that appears.

The [Auto Adjustment] window appears.

Automatic Adjustment Using IB

3 Click the [Auto Adjust Image] button to adjust the 
image.

The image is adjusted.

4 Check the adjustments.

5 Click the [OK] button.
The [Auto Adjustment] window closes.

Auto Adjustment window

Checkmark to display the image before adjustments
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6 Save as a separate image.
In the viewer window, click [Save].

The save dialog box appears.

7 Enter a new name, specify the save location and then 
click the [Save] button.

The edited image is saved as a separate image from the original 
image.

Enter the new name Specify the save location

You can adjust the brightness and saturation of images.

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Color/Brightness 
Adjustment] in the menu that appears (p.23).

The [Color/Brightness Adjustment] window appears.

3 Select the [Color Adjustment] tab sheet and adjust 
the image. 

Move the slider to the right to make the [Saturation] of an image 
to appear more vivid and the [Brightness] appear brighter. Move 
the slider to the left to make the [Saturation] of an image weaker, 
and the [Brightness] of an image appears darker.
The image is adjusted.

4 Check the adjustments and then click the [OK] 
button.

5 Save the image as a separate image (Description on the 
left).

Adjusting Color and Brightness

Color/Brightness Adjustment window

Drag to the left or right to adjust
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You can trim only the part of an image you need, or change the 
composition of an image where an image shot horizontally becomes 
vertical.

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Trim Image] in the menu 
that appears (p.23).

The [Trim Image] window appears.

3 Drag the trimming range.

The trimming range can be moved by dragging.
You can change the trimming range by dragging the four corners 
and the four sides of the trimming range.

Trimming an Image

Trim Image window

Drag

4 Click the [Trim Image] button to trim the image.

The image is trimmed.

5 Check the trimming and then click the [OK] button. 

6 Save the image as a separate image (p.24).
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You can insert the date and time you shot an image and text into an 
image as text.

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Insert Text] in the menu 
that appears (p.23).

The [Insert Text] window appears.

3 Drag the range for inserting text.

The text insertion range can be moved by dragging.
You can change the text insertion range by dragging the four 
corners and the four sides of the text insertion range.

Inserting Text into Images

Insert Text window

Drag

4 Using the keyboard, enter the text you want to insert.

The text you enter appears in the window.

5 Check your entry and then click the [OK] button.

6 Save the image as a separate image (p.24).
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You can make the overall atmosphere of an image harder or softer.

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Sharpness] in the menu 
that appears (p.23).

The [Sharpness] window appears.

3 Adjust the image.

Move the slider to the right to make an image harder and to the 
left to make an image softer.
The image is adjusted.

Adjusting Sharpness

Sharpness window

Drag right to adjust

4 Check the adjustments and then click the [OK] 
button.

5 Save the image as a separate image (p.24).
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You can automatically detect and correct red-eye that occurs when you 
photograph people using a flash.

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Red Eye Correction] in 
the menu that appears (p.23).

The [Red Eye Correction] window appears.

3 Click the [Start] button to correct.

The image is corrected.

4 Check the corrections and then click the [OK] 
button.

5 Save the image as a separate image (p.24).

Correcting Red-Eye Automatically

Red Eye Correction window

Correcting Red-Eye Manually
You can manually correct red-eye that cannot be corrected 
automatically.

1 Display the [Red Eye Correction] window (Description 
on the left).

2 Display the image enlarged and then select [Manual 
Mode].

Display the image enlarged
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3 Click on the places in the image you want to correct.
When you move the mouse cursor on the places to be corrected, 
[ ] is displayed.

The image is corrected.

4 Check the corrections and then click the [OK] 
button.

5 Save the image as a separate image (p.24).

Click

Utilizing Your Images
You can view your images as a slide show, send them in an e-mail or 
use them as wallpaper or screen savers for your computer.

You can display selected images across the whole window and switch 
between them as a slide show.

1 Select images.

2 Select the [View] menu  [Slide Show Options].

The [Slide Show Options] window appears.

Viewing Images as a Slide Show
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3 Set the play method and transition effect for the slide 
show and then click the [OK] button.

The [Slide Show Options] window closes. 

4 Click [SlideShow].

The Slide Show window appears and the slide show begins.

Slide Show Options window

*1 The image is selected for printing. When the slide show ends and 
returns to the main window, the print dialog box is displayed.

*2 The image is selected. When the slide show ends and returns to 
the main window, the image is displayed as being selected.
When all the images have been displayed, the Slide Show 
window closes and returns to the main window.
To end the slide show half-way through, click [ ].

Slide Show window

Rating setting
Selects the image*2

Prints the image*1

Switches to the first image
Switches to the previous image

Ends the slide show
Switches to the last 
image
Switches to the next 
image
Pauses the slide 
show
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You can attach a selected image to an e-mail and send it.
The image to be sent is a copy of the original image and therefore the 
original image remains unaffected on your computer.

1 Select an image.

2 Click [Internet] and then select [Create Image for 
Email] in the menu that appears.

The [Create Image for Email] window appears.

Sending an Image by E-Mail 3 Select [Resize, compress, and send] and then click 
the [Next] button.

The settings window display changes.

Create Image for Email window
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4 Set the compression and then click the [Next] 
button.

If the file is too large, you may not be able to send it attached to 
an e-mail. We recommend that you keep the size of images to 
300KB or smaller.
The settings window display changes.

The image file size is displayed when you set [Resize] and 
[Quality], and then click the [Compress] button

Checks the image quality
Set the reduction percentage 

Checks the image size

Set the 
JPEG 
image 
quality

5 Click the [Finish] button. 

The image is displayed in the main window and the e-mail 
software being used starts up.
Attach to the e-mail [Email Images] in the folder area and then 
send the e-mail.
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You can make a selected image wallpaper for your computer.
The JPEG image for the wallpaper (extension “.JPG”) is created using a 
copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Select the [File] menu  [Export Images].

The [Write a still image] window appears.

Creating Wallpaper from an Image 3 Select [Export an Image as Wallpaper] and then click 
the [Next] button.

The [Set Image as Wallpaper] window appears.

4 From the list box, select the wallpaper display 
method and then click the [Finish] button.

The image you selected for your wallpaper is applied as 
wallpaper.

Write a still image window

Set Image as Wallpaper window
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1 On the desktop, launch [System Preferences] from the Dock and then 
click [Desktop & Screen Saver].

2 Select the [Desktop] tab sheet. 
3 Select the file for the wallpaper and then click [ ] to close the dialog 

box.

To revert to the original wallpaper

You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SLIDESAVER”) is created 
using a copy of an image and therefore the original image remains 
unaffected.

1 Select an image.

2 Select the [File] menu  [Export Images].

The [Write a still image] window appears.

Creating a Screen Saver from an Image
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3 Select [Export as a Screensaver] and then click the 
[Next] button.

The [Export as a Screensaver] window appears. 

4 Using the keyboard, enter a name and then click the 
[Finish] button.

The screen saver data is saved in the [Screen Savers] folder.

Export as a Screensaver window

5 Specify the saved screen saver on your computer.
On the desktop, launch [System Preferences] from the Dock and 
then click [Desktop & Screen Saver]  [Screen Saver] tab sheet 
to display the [Screen Saver] tab sheet. 

6 Close the [Desktop & Screen Saver] window.
Click [ ] on the top left of the dialog box.

Select the saved screen saver data



36

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

Printing Multiple Images on One Sheet of Paper (Index Printing)
You can arrange multiple images in index format and print them on one 
sheet of paper.

1 Select the images.

2 Click the [Print] button and then select [Index Print] 
from the menu that appears.

The [Index Print] window appears.

3 Specify settings such as the paper type and the 
number of prints, and then click the [Print] button.

Printing begins.

Print preview

Index Print window

For a list of index print window functions, refer to p.69.
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Arranging Images Freely and Printing (Layout Printing)
You can lay out images freely and then print them.

1 Select the images.

2 Click the [Print] button and then select [Layout Print] 
from the menu that appears. 

The [Layout Print] window appears.

3 Lay out your images by dragging them and then click 
the [Print] button.

Printing begins.
Print preview

Layout Print window

For a list of layout print window functions, refer to p.70.



3

38

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

Using High-Level Functions
This chapter explains more advanced high-level functions than those 
described in Chapter 2.

Comparing Multiple Images ..................................... 39
Viewing Images in Date/Time Order..........................  40

Viewing Shooting Information for an Image ............. 41
Changing the Size and Type of an Image and 
Saving ..............................................................  41
Exporting Shooting Information................................ 42
Organizing Images Using High-Level Functions ...... 43

Setting Keywords in Images ......................................  43
Entering Comments into Images ...............................  43
Saving Multiple Images with New File Names...........  44
Classifying Images by Shot Date...............................  44

Searching for Images ............................................... 46
Performing Advanced Editing................................... 47

Adjusting the Color of an Image in RGB....................  47
Adjusting the Brightness Level ..................................  48
Adjusting the Tone Curve ..........................................  48
Transferring Images to Other Image Editing Software...  49
Merging Images to Create Panorama Images...........  50

Adjusting RAW Images............................................  51
List of RAW Image Task Main Window Functions ...  53
List of Image Quality Adjustment Window 
Functions ........................................................  54

White Balance Files and Tone Curve Files for the 
EOS-1D Series Cameras ......................................  55

Saving White Balance Files.................................... 55
Saving Tone Curve Files (Excludes the EOS-1D 
Mark III) .............................................................  55

Adding Sound to Images/Playing Back ...................  56
Adding Sound to Images ............................................ 56
Playing Back Sound ................................................... 56
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Comparing Multiple Images
To compare multiple images, you can split the viewer window into two, 
three or four and display multiple images at the same time.
You can also align the display position of enlarged images and compare.

1 In the main window, select the images you want to 
compare (p.8).

2 Click [ ] (View Image) (p.65).
The viewer window appears.

3 Click [Number of Displays] and select the number of 
images you want to display at the same time.

The viewer window is split and the multiple images are displayed 
at the same time.

Example of display when [4-Page View] is selected.

4 Click [Synchronize] and then enlarge the image.

The synchronize display appears and all the images are displayed 
at the same display magnification and in the same position.
The navigator window that displays the enlargement display 
position appears and you can check and move the enlargement 
display position (p.15).
Click [Synchronize] again to cancel the synchronize display. You 
can now change the display magnification and move the 
enlargement display position for each image.
To return to full view, select [Fit to window] from the list box under 
each image.
To cancel the split display, click [Number of Displays] at the 
bottom of the window and then select [Single View] from the 
menu that appears. 

Click Select the display magnification
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You can view images in the time tunnel window, in the order of shot date 
and time.

Click the [TimeTunnel] tab sheet.

The main window display switches to TimeTunnel Mode.

Viewing Images in Date/Time Order

Click

To select multiple images, click on the images while holding 
down the < shift > key on the keyboard.

Main window (TimeTunnel Mode)
Drag up or down to move the time 
tunnel forward or backward

Click to select an imageThe images inside the folder 
selected in the folder area on the 
left of the window are displayed

For a list of TimeTunnel Mode functions, refer to p.66.
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Viewing Shooting Information for an Image
1 Display List Mode (p.65) or TimeTunnel Mode (p.66).

2 Select the image for which you want to view the 
information.

3 Select the [File] menu  [Get Info].
The [File Information] window appears. 

In Preview Mode, the same information as the [File Information] 
window is displayed on the information display area (p.64).

Changing the Size and Type of an Image and Saving
You can change the size of an image or convert it to a TIFF image 
(extension “.TIFF”) or a PICT image (extension “.PCT”) and save it. 
Because the image is saved as a separate image, the original image 
remains unaffected.

1 Select an image.

2 Select the [File] menu  [Export Images].
The [Write a still image] window appears.

3 Select [Edit and Save Image] and then click the 
[Next] button.

The [Edit and Save Image] window appears.
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4 Specify the image size, type and save destination, 
and then click the [Finish] button.

The image is saved as an image separate from the original 
image.

Sets the image size and type

Sets the 
save 
destination

Exporting Shooting Information
You can export as a text file the shooting information recorded to the 
image.

1 Select an image.

2 Select the [File] menu  [Export Images].
The [Write a still image] window appears.

3 Select [Export Shooting Properties] and then click 
the [Next] button. 

The [Export Shooting Properties] window appears.

4 Specify the export shooting information, the file 
name, and the save destination, and then click the 
[Finish] button.

The shooting information is saved as a text file (extension 
“.TXT”).

Sets the 
save 
destination
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Organizing Images Using High-Level Functions
You can organize images using high-level functions such as setting 
keywords and entering comments, renaming multiple files in a single 
operation and classifying images by shot year/month/date, all of which 
are useful when organizing your images.

You can set keywords to identify images. The set keywords are also 
useful when searching for images (p.46).

1 Select an image.

2 Select the [Edit] menu  [Keyword]  [Settings].
The [Keywords Setting] window appears.

3 Select the keyword(s) and then click the [OK] button.

The keyword is set in the image.

Setting Keywords in Images

You can enter information relating to images as comments. The entered 
comments are also useful when searching for images (p.46).

1 Display the [File Information] window (p.41).

2 Click the [ ] button in [Comment].
A field for entering comments is displayed.

3 Enter text and then press the < return > key on the 
keyboard.

The entered text is saved in the image.

Entering Comments into Images



44

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

You can copy multiple images and save them with new file names in a 
single operation.

1 Select all the images you want to save with new file 
names (p.8).

2 Select the [File] menu  [Export Images].
The [Write a still image] window appears.

3 Select [Edit and Save Image] and then click the 
[Next] button. 

The [Edit and Save Image] window appears.

4 Checkmark [Rename the file], specify the file name 
and save destination, and then click the [Finish] 
button. 

Images separate from the original images are saved with the new 
names.

Saving Multiple Images with New File Names
Multiple images can be classified into different folders according to shot 
date.

1 Select all the images to be classified (p.8).

2 Select the [File] menu  [Organize Image]  [Sort 
Images].

The [Sort Images] window appears.

3 Select [The files will be separated into folders for 
each shooting date.] and then click the [Next] button. 

The [Organize by Shooting Date] window appears.

Classifying Images by Shot Date
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4 Specify the folder structure, the file names, and the 
save destination, and then click the [OK] button.

Images are classified by shot date.

Settings for Folder Structure
Setting Item Description

YearMonthDate Classifies images by creating a first-level folder 
according to shot year/month/date.

Year/YearMonthDate Classifies images by creating a second-level 
folder for the shot year, and the month and date.

Year/Month/
YearMonthDate

Classifies images by creating a third-level folder 
for the shot year, the month, and the date.

Year/NewName Classifies images by creating a new folder with a 
new name inside the shot year folders.

NewName/
YearMonthDate

Classifies images by creating folders for shot 
year/month/date inside a folder with a new name.

YearMonthDate/
NewName

Classifies images by creating a new folder with a 
new name inside the shot year/month/date 
folders. 



46

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

Searching for Images
You can search for images by ratings (p.15), shot date, comments (p.43) 
and keywords (p.43).

1 Select the [File] menu  [Search].
The [Set Search Criteria] window appears.

2 Specify the search criteria and then click the [Search 
Now] button.

The search begins and the images that match the criteria are 
displayed in the [Search Results] window. 

3 Click the [Finish] button to close the [Search 
Results] window.

The display returns to the main window.

4 Check the searched images in the main window.
The searched images are displayed in the main window. Also, 
the [Search Results] folder is displayed in the folder area, and by 
selecting this folder, you can display the searched images at any 
time.

The images inside the [Search Results] folder are stored until 
you either perform another search or quit IB.
Any work you do on images inside the [Search Results] folder will 
be applied to all the original images. Therefore, please be aware 
that if you edit or delete images inside the [Search Results] 
folders, the original images will be edited or deleted also.
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Performing Advanced Editing
This section explains image editing using high-level functions based on 
the assumption that you are familiar with handling standard image 
editing software.
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.

You can adjust the color of an image in RGB (red, green, blue).

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Color/Brightness 
Adjustment] in the menu that appears (p.23).

The [Color/Brightness Adjustment] window appears.

3 Select the [RGB Adjustment] tab sheet and adjust 
the image. 

The image is adjusted.

Adjusting the Color of an Image in RGB

Drag to the left or right to adjust

4 Check the adjustments and then click the [OK] 
button.

5 Save the image as a separate image (p.24).
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You can adjust the level of brightness (balance).

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Level Adjustment] in the 
menu that appears (p.23).

The [Level Adjustment] window appears.

3 Adjust the image.

The image is adjusted.

4 Check the adjustments and then click the [OK] 
button.

5 Save as a separate image (p.24).

Adjusting the Brightness Level 

Drag to the left or right to adjust

Drag left to adjustDrag right to adjust

You can adjust the brightness, contrast and color of a specific area by 
changing the tone curve.

1 Display the image to edit in the viewer window (p.14).

2 Click [Edit] and then select [Tone Curve Adjustment] 
in the menu that appears (p.23).

The [Tone Curve Adjustment] window appears.

3 Adjust the image.

The image is adjusted.
The horizontal axis shows the input level and the vertical axis 
shows the output level.
The maximum number of [ ] is 10.
To delete a [ ] , press the < delete > key.

Adjusting the Tone Curve

Click to add a [ ] (point)
Adjust by dragging [ ]
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4 Check the adjustments and then click the [OK] 
button.

5 Save as a separate image (p.24).
You can transfer images to image editing software other than IB.

1 In the main window, select the [ImageBrowser] menu 
 [Preferences].
The [Preferences] window appears.

2 From the menu, select [Browser Window] and then 
click the [Add] button.

The [Select File] window appears.

3 Select the image editing software to transfer to, and 
then click the [Open] button

The selected software is registered.

4 Click the [OK] button and then close the 
[Preferences] window.

5 Select the image you want to transfer to the image 
editing software.

6 Select the [Edit] menu  [Edit with Registered 
Application]  image editing software to transfer to.

The selected image editing software starts up and then image is 
displayed.

Transferring Images to Other Image Editing Software
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You can merge up to four JPEG images to create panorama images. 
For merging images, start up the image-merging software “PhotoStitch” 
from IB and use.

1 Select multiple images to merge (p.8).

2 Select the [Edit] menu  [PhotoStitch].
PhotoStitch starts up and the main window appears.

3 Check the arrangement of the images to be merged 
and click the [2. Merge] tab sheet.

If the arrangement of the images to be merged is not correct, 
drag the images to rearrange them.

The window switches to the [2. Merge] tab sheet.

Merging Images to Create Panorama Images 4 Click [Start] to merge.

The images are merged and displayed.

5 Click the [3. Save] tab sheet.
The display switches to the [3. Save] tab sheet.
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6 Check the save range and then click [Save].

The [Save As] dialog box appears.

7 Specify the save destination and then click the 
[Save] button.

The merged images are saved.

8Select the [PhotoStitch] menu  [Quit PhotoStitch] 
to quit.

PhotoStitch quits.

Save range
Drag [ ] to change the range

See also the Help that are displayed when you click [ ] on the 
right of the window for information on operating PhotoStitch and 
PhotoStitch functions.

Adjusting RAW Images
You can make the same adjustments (reset processing conditions) to 
RAW images as the functions that are available on the camera, such as 
brightness and white balance adjustment. You can also convert edited 
RAW images to JPEG or TIFF images and save them.
Because only the image processing conditions are changed when a 
RAW image is adjusted, the original image data remains totally 
unaffected. For this reason, image deterioration that usually 
accompanies editing does not occur and you can readjust, redo or undo 
changes knowing that you can always revert to the original shot 
condition of the image.

1 Select a RAW image.

2 Select the [File] menu  [Processing RAW Images].
RAW Image Task starts up and the main window appears.

3 Adjust the image in the [Image Quality Adjustment] 
window.

The image is adjusted.
The adjustment items in the [Image Quality Adjustment] window 
vary according to the model of camera used for shooting the 
RAW image. For more details, refer to p.54.

RAW Image Task main window

Image Quality 
Adjustment 
window
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4 Click [Save].

The [Save] dialog box appears.

5 Specify the type for the image to be saved and the 
save destination, and then click the [Save] button.

The processing dialog box appears and the JPEG image or TIFF 
image that has been converted from a RAW image is saved in 
the specified place. The RAW image remains unaffected.

6 Select the [RAW Image Task] menu  [Quit RAW 
Image Task].

RAW Image Task quits.
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Sets a check mark
Selects/deselects the image

Shows/hides the shooting 
information

Shows/hides the [Image Quality Adjustment] window (p.54)
Rotates the image

Fit-to-window view
100% (actual pixel size) 
view
Enlargement/reduction 
ratio display
Enlargement/reduction 
display

Image display area

Cursor coordinates position and RGB value 
(8-bit conversion)

Displays the image selected in the 
thumbnail image display area

Thumbnail image 
display area

Switches between 
displayed images

Transfers the image to 
image editing software

Saves the 
image (p.52)

Cancels [ ], [ ] or [ ]
Zooms in

Zooms out
Moves the enlargement display position

Shows/hides the [Histogram] window
Shows/hides the [Navigator] window

List of RAW Image Task Main Window Functions
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List of Image Quality Adjustment Window 
Functions
You can adjust RAW images (reset processing conditions) with the 
same functions available on the camera. Adjustment settings displayed 
in the [Image Quality Adjustment] window vary depending on the 
camera model used for shooting the RAW image.

The settings at the time of shooting are displayed in bold and 
italics in the list boxes.

Example of EOS-1D Mark III display

Brightness adjustment

Click white balance

Saves the set white balance 
as a white balance file

Loads a Picture Style file and 
applies it to the image

Applies and redisplays multiple 
adjustment settings in a single 
operation

Cancels all settings and reverts to the status 
at the time of shooting

Checkmark to redisplay for each adjustment made

1 Remove the check mark from [Preview].
2 Set multiple adjustment items.
3 Click the [Update] button.

All the adjustments are saved to the image and redisplayed in one 
operation.

You can apply the settings that have been adjusted in the [Image Quality 
Adjustment] window to another image by selecting the [Edit] menu  
[Development Conditions]  [Copy] or [Paste] in the RAW Image Task 
main window (p.53). You can also select [Save] or [Load] to save or 
download the settings as a separate file from the image (extension 
“.DVP”).

Applying multiple adjustment settings to an image at one 
time

Applying adjustment settings to another image

It takes approximately 2 to 4 seconds until the adjusted image is 
redisplayed (undergone development processing) (when using 
the following: OS: Mac OS X 10.4; CPU: 1.6 GHz PowerPC G5; 
RAM: 512MB). However, the time it takes to redisplay an image 
varies greatly depending on the camera model used to shoot the 
image, computer type and the subject of the image.
A Picture Style file is an extended function of Picture Style. It is a 
file that offers effective image characteristics for an image shot in 
an extremely limited scene. For more details on Picture Style files, 
refer to the Canon’s web site.
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White balance and tone curve (excludes EOS-1D Mark III) adjustments 
made to RAW images of EOS-1D series cameras can be saved as a file 
as explained below and then registered to a camera and used.
For information on registering cameras, see the two related pages 
below in “Chapter 2: Setting the Camera from Your Computer” in the 
“EOS Utility Instruction Manual” (PDF electronic manual).

For details on white balance files, refer to “Registering Personal White 
Balance in the Camera”.
For details on tone curve files, refer to “Setting Parameters and 
Applying to the Camera”.

Saving White Balance Files

1 Adjust white balance in the [Image Quality 
Adjustment] window.

2 Click the [ ] button to save as a white balance file.
Click the [ ] button to save the adjusted white balance results 
as a white balance file (extension “.WBD”).

3 Use EOS Utility to register the saved file to the 
camera.

White Balance Files and Tone Curve Files 
for the EOS-1D Series Cameras

Saving Tone Curve Files 
(Excludes the EOS-1D Mark III)

1 Click the [ ] button in the [Image Quality 
Adjustment] window and adjust the tone curve.

2 Click the [Save] button to save as a tone curve file.
Click the [Save] button in the [Tone curve] dialog box to save the 
adjusted tone curve as a tone curve file (extension “.TCD”).

3 Use EOS Utility to register the saved file to the 
camera.

White balance files are not compatible with other camera models.
Tone curve files for the EOS-1Ds Mark II and the EOS-1D Mark II 
are compatible and tone curve files for the EOS-1Ds and the 
EOS-1D are compatible.
White balance files and tone curve files are compatible with 
Windows and Macintosh computers.
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Adding Sound to Images/Playing Back
You can add sound to images and play back sound which you have 
added to images with a camera that has a sound record function.

You can add a sound file to an image.
A Mac OS X function is used for sound recording. When inputting sound 
from external equipment, connect the external equipment to your 
computer beforehand.

1 Select an image to which you want to add sound.

2 Select the [File] menu  [Sound]  [Record].
The audio recording dialog box appears.

3 Click [ ] (recording button) and begin recording the 
sound to be added to the image. Click the [Save] 
button to stop recording.

The recorded sound file is added to the image. The [ ] icon is 
displayed in the image to which the sound file was added.

Adding Sound to Images
You can play back sound files that are attached to images.

1 Select an image to which a [ ] icon is attached.

2 Select the [File] menu  [Sound]  [Play].
The sound is played back.

Playing Back Sound
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Preferences
You can change any of the IB functions in the preferences window, 
making them easier to use.

Preferences .............................................................  58
Browser Window Settings........................................... 58
Viewer Window Settings............................................. 59
Confirmation Dialog Box Settings............................... 59
Thumbnail Cache Settings ......................................... 59
Processing When Rotating Settings ........................... 60
Print Settings .............................................................. 60
Units Settings ............................................................. 60
Color Management Settings ....................................... 60
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Preferences
You can change any of the IB functions in the preferences window. 
Check the settings displayed for each window before making changes.

1 Select the [ImageBrowser] menu  [Preferences].

2 From the menu, select the dialog box you want to 
display, specify your settings, and then click the 
[OK] button. 

You can change the background color of the main window (browser 
window) as well as the color of the thumbnail image frames. 
You can also register other image editing software to which to transfer 
images.

Browser Window Settings
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You can set the shooting information displayed in the viewer window 
(p.67).

Viewer Window Settings

In the viewer window, click the [Show Information] button (p.67) and in 
the menu that appears, select [Show Shooting Information] to display 
the shooting information. 

To display the shooting information in the viewer window

You can set the software so that confirmation dialog boxes displayed 
after each operation are not displayed.
The items you uncheck are not displayed. 

You can delete the cache data for each volume.
Checkmark the volumes for which you want to delete the cache data.

Confirmation Dialog Box Settings

Thumbnail Cache Settings
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You can make settings related to image rotation.

You can make settings for image printing.

Processing When Rotating Settings

Print Settings

You can select [mm] or [inches] as the measurement unit. 

You can make settings for color management.

Units Settings

Color Management Settings
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Reference
This reference section has been provided to enhance your experience 
using IB.
It contains various troubleshooting solutions, how to delete IB from your 
computer and explanations of the various windows’ functions.
An Index is provided at the end of the chapter for you to easily find 
information you are looking for.

Troubleshooting.......................................................  62
Deleting the Software (Uninstalling) ........................  63
List of Main Window Functions................................  64

Preview Mode............................................................. 64
List Mode.................................................................... 65
TimeTunnel Mode....................................................... 66

List of Viewer Window Functions.............................  67
List of One Photo per Page Print Window Functions...  68
List of Index Print Window Functions ......................  69
List of Layout Print Window Functions ....................  70
Index........................................................................  71

About This Instruction Manual ................................ 73
Trademark Acknowledgments ................................ 73
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Troubleshooting
If IB is not operating correctly, refer to the items below.

You cannot install software unless you are logged into an account with 
Administrator privileges. Log in again into an account with 
Administrator privileges. 
For how to log in and how to specify Administrator settings, refer to 
the User’s Manual for the Macintosh computer you are using or for 
Mac OS X.

IB does not operate correctly on a computer if its system 
requirements does not meet. Use IB on a computer with compatible 
system requirements (p.2).
Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.2), if other applications are running at the 
same time as IB, you may not have sufficient RAM (memory). Quit 
any applications other than IB.
The software preferences file may be corrupted. Quit all applications 
and follow the procedure below to delete the preferences file from the 
[Preferences] folder before restarting IB.
In the hard disk drive where the system is saved, open the [Users] 
folder  folder of the logged in user  [Library] folder  [Preferences] 
folder, and delete the preferences files below. 

Installation could not be completed correctly

IB does not work

Preferences Description
ImageBrowser Preferences Preferences file for the 

ImageBrowser

RAW Image Task Pref Preferences file for the RAW Image 
Task

PhotoStitch Preferences Preferences file for the PhotoStitch

Images that are not supported by IB (p.2) do not display. There are 
various types of JPEG and TIFF images, so JPEG images other than 
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif 
compatible images may not display properly.
With initial settings, the color of images that have been shot in Adobe 
RGB appear weak. In this case, check the [Color Management] 
window in preferences and checkmark [Apply color matching] (p.60). 
Color management is performed and the color of the image shot with 
an Adobe RGB setting and the image shot with an sRGB setting are 
matched.

Images do not display properly
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Deleting the Software (Uninstalling)
Quit any applications before uninstalling the software.
To uninstall the software, log in with Administrator privileges.
To prevent computer malfunctions, always restart your computer after 
you have uninstalled the software.

1 Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

2 Drag the [ImageBrowser] folder to the Trash.

3 Select the [Finder] menu on the desktop  [Empty 
Trash].

The software is deleted.

4 Restart your computer.

You cannot retrieve data that you have emptied into the Trash 
and deleted, so be particularly careful when deleting data.
You cannot install the software again if you have just moved the 
[ImageBrowser] folder to the trash. Be sure to select the [Finder] 
menu  [Empty Trash]. 
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List of Main Window Functions
Preview Mode

Shows/hides the folder area

Information display area

*1 Images in folders selected here are displayed on the thumbnail image 
display area.

*2 Images selected here are displayed on the image display area.

Folder area *1

Thumbnail image display 
area*2

Image display area

Shows/hides the task buttons
Shows/hides the information 
display area
Selects/deselects all the 
images
Number of selected images/
Total number of images

Deletes images and folders (p.21)
Prints images (p.11, p.36, p.37)

Connects to the internet
Slide show (p.30)

Viewer window (p.67)
Starts up EOS Utility/CameraWindow MC 
(p.5, p.7)

Filter display 
(p.16)
Enlarges/
reduces the 
thumbnail 
images (p.9)
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List Mode

RAW image icon

*1 Images in folders selected here are displayed on the image display 
area.

Folder area *1

Shows/hides the folder area
Shows/hides the task buttons

Selects/deselects all the 
images

Bracketing icon

Image display area

Protect icon
Audio recording icon

Filter display 
(p.16)
Enlarges/
reduces the 
thumbnail 
images (p.9)

Number of selected images/
Total number of images

Deletes images and folders (p.21)
Prints images (p.11, p.36, p.37)

Connects to the internet
Slide show (p.30)

Viewer window (p.67)
Starts up EOS Utility/CameraWindow MC 
(p.5, p.7)
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TimeTunnel Mode

Moves the time tunnel 
forward/backward

*1 Images in folders selected here are displayed on the image display 
area.

Folder area *1

Number of selected images/
Total number of images

Slide show (p.30)
Viewer window (p.67)

Starts up EOS Utility/CameraWindow MC 
(p.5, p.7)

Shows/hides the tool panel 

Image display area

Deletes images and folders (p.21)
Prints images (p.11, p.36, p.37)

Connects to the internet
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List of Viewer Window Functions

Image display area

Rating (p.15)

Shows/hides the 
shooting information 
and AF point 
(p.10, p.14)

Display magnification

Prints the images (p.11)
Full view display (p.10)

Displayed image size

Split displays (p.39)
Edits the images (p.23)

Saves the images (p.24)

Synchronize (p.39)

Switches 
between images

Display magnification 
(p.15)
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List of One Photo per Page Print Window Functions

Page settings

Shot date and 
time settings

Printer selection 
and settings

Print preview

Number of prints

Trims the image

Rotates the imageSwitches the printing image
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List of Index Print Window Functions

Print information 
settings

Printer selection 
and settings

Print preview

Rotates the imageSwitches the printing image

Trims the image

Page settings
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List of Layout Print Window Functions

Print preview

Rotates the image Deletes an image
Reverts to the original condition

Number of images per page

Trims the image

Printer selection 
and settings

Page settings

Sets the printing 
style
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Index
A
Adding Sound to Images.....................................................................  56
Adjust JPEG Images.....................................................................  23, 47
Adjust RAW Images............................................................................  51
Adjusting (JPEG or TIFF Image)...................................................  23, 47

Adjusting in RGB ..........................................................................  47
Adjusting the Brightness...............................................................  24
Adjusting the Brightness Level .....................................................  48
Adjusting the Saturation ...............................................................  24
Adjusting the Sharpness ..............................................................  27
Adjusting the Tone Curve.............................................................  48
Automatic Adjustment ..................................................................  23
Correcting Red-eye ......................................................................  28

Adjusting (RAW image).......................................................................  51
Adjusting Color Saturation............................................................  54
Adjusting Color Tone....................................................................  54
Adjusting the Contrast ..................................................................  54
Adjusting the Sharpness ..............................................................  54
Adjusting White Balance ..............................................................  54
Click White Balance .....................................................................  54
Picture Style .................................................................................  54
Picture Style File ..........................................................................  54

Adjusting Images in RGB....................................................................  47
Adjusting the Brightness .....................................................................  24
Adjusting the Brightness Level............................................................  48
Adjusting the Saturation......................................................................  24
Adjusting the Sharpness ...............................................................  27, 54
Adjusting the Tone Curve ...................................................................  48
Attach an Image to an E-mail..............................................................  31
Automatic Adjustment .........................................................................  23

B
Batch Change the File Name of Images .............................................  44
Browser Window.................................................................................  71
Browser Window Settings (Preferences) ............................................  58

C
Change File Name..............................................................................  20

Change Folder Name .......................................................................... 20
Change the Display Magnification ......................................................... 9
Changing the Size and Type of an Image and Saving ........................ 41
Checking the Shooting Information ..................................................... 41
Classifying the Images by Shot Date................................................... 44
Click White Balance............................................................................. 54
Color Management Settings (Preferences) ......................................... 60
Compare Multiple Images.................................................................... 39
Confirmation Dialog Box Settings (Preferences) ................................. 59
Correcting Red-eye ............................................................................. 28
Creating a Folder................................................................................. 18

D
Delete

Delete Folders............................................................................... 21
Delete Images............................................................................... 21
Delete the Software ...................................................................... 63

Delete Folders ..................................................................................... 21
Delete Images ..................................................................................... 21
Delete the Software (Uninstalling) ....................................................... 63
Deleting the IB (Uninstalling) ............................................................... 63
Displaying Images Shot with Adobe RGB ........................................... 62
Downloading an Image to Your Computer ............................................ 5

Downloading Images from a Camera ............................................. 5
Downloading Images from a Card Reader...................................... 6

Downloading Images ............................................................................. 5
Downloading Images from a Card Reader ............................................ 6

E
Editing.................................................................................................. 71
Enlarge Images ............................................................................... 9, 15
Entering Comments............................................................................. 43
Exporting Shooting Information ........................................................... 42

F
Favorite Folders................................................................................... 21
Full View Display ................................................................................. 10

Adjusting

Main Window
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I
Image Quality Adjustment Window...............................................  51, 54
Index Printing ......................................................................................  36
Insert Text ...........................................................................................  26
Inserting Text into Images...................................................................  26

K
Keywords Settings ..............................................................................  43

L
Layout Printing ....................................................................................  37
List Mode (Main Window) ...............................................................  8, 65

M
Main Window (Browser Window) ....................................................  5, 64
Main Window (RAW Image Task).................................................  51, 53
Merging Panorama Images.................................................................  50
Move or Copy Folders.........................................................................  19
Move or Copy Images.........................................................................  19

N
Navigator Window...............................................................................  15

O
One Photo per page Printing ..............................................................  11
Operating with EOS Utility ....................................................................  5

P
Picture Style File .................................................................................  54
Playing Back Sound............................................................................  56
Preferences.........................................................................................  58

Browser Window Settings ............................................................  58
Color Management Settings.........................................................  60
Confirmation Dialog Box Settings.................................................  59
Print Settings ................................................................................  60
Processing When Rotating Settings.............................................  60
Thumbnail Cache Settings ...........................................................  59
Units Settings ...............................................................................  60
Viewer Window Settings...............................................................  59

Preview Mode (Main Window)................................................... 7, 17, 64
Print Settings (Preferences) ................................................................ 60
Printing

Index Printing ................................................................................ 36
Layout Printing .............................................................................. 37
One Photo per page Printing ........................................................ 11

Processing When Rotating Settings (Preferences) ............................. 60

Q
Quitting IB............................................................................................ 12

R
Ratings ................................................................................................ 15

S
Save the White Balance File ............................................................... 55
Saving the Tone Curve File ................................................................. 55
Searching for Images .......................................................................... 46
Setting a Screen Saver........................................................................ 34
Setting a Wallpaper ............................................................................. 33
Setting an Image as a Screen Saver................................................... 34
Setting an Image as Wallpaper ........................................................... 33
Slide Show........................................................................................... 29
Starting up IB......................................................................................... 5
Supported Images ................................................................................. 2
Synchronize Display ............................................................................ 39
System Requirements ........................................................................... 2

T
Thumbnail Cache Settings (Preferences)............................................ 59
Thumbnail Display (Main Window) ........................................................ 8
TimeTunnel Mode (Main Window)................................................. 40, 66
Transfer Images to other Image Editing Software ............................... 49
Trimming.............................................................................................. 25
Trimming an Image.............................................................................. 25

U
Units Settings (Preferences)................................................................ 60
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V
View an Image ......................................................................................  7
View Images in Date/Time Order........................................................  40
Viewer Window .......................................................................  10, 14, 67
Viewer Window Settings (Preferences) ..............................................  59

W
White Balance.....................................................................................  54

Click White Balance .....................................................................  54

About This Instruction Manual
It is prohibited to reproduce, in whole or part, the contents of this 
Instruction Manual without permission.
Canon may change without notice the software specifications and 
contents of this Instruction Manual.
The software screens and displays printed in this Instruction Manual 
may differ slightly from the actual software.
The content of this Instruction Manual has been reviewed thoroughly. 
However, if you should notice any errors or omissions, please contact 
a Canon Service Center.
Please note that irrespective of the above-mentioned, Canon does 
not take responsibility for the outcome of the operation of the 
software.

Trademark Acknowledgments
Macintosh is a trademark of Apple Inc., registered in the United States 
and other countries.
Other names and products not mentioned above may be registered 
trademarks or trademarks of their respective companies.
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